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2 Kiosk Administration System

1 Introduction

Welcome to the Kiosk Administration System (hereafter referred to
as the System or KAS).

Anglo Platinum Kiosk Administration
File = ‘Wiew * Folder =~ Window * Help = Type & b far . ‘,‘ I

EENM.'igamr e #Ang‘o Platinum Kiosk Admintstration &R agister for Access

4 & angle Platinum Kiosk Adminiz E Ragisbar for Accasd x

.&R.q]i:‘ber for Access
E:Lng n Account Registration
i

& Agcount Details
Designatian
Nama
Surname
il
Email
Password
Confirm Password
Mobile
Tal

Faz

ri _j % '—’E @Clnu[

< >

The purpose of this system is to allow you to manage your kiosks in
accordance with current company policies. The system allows you to
define media, taxonomies, emergency procedures and news items for
each kiosk on a per site area basis.
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2.1

Quick Guide

Loading

To load the system, do the following (skip any of the initial steps
you may have already taken):

1.0pen Internet Explorer (or similar web browser, ex. FireFox) and
type the following URL into the Address Bar and press Enter:

& hit-fisden iods angogatoetf 1 v

2.Your screen will now look like this:

Anglo Platinum Kiosk Administration
File * Wiew * Folder ¥ ‘Window ™ Help Typea e Tar help ol -] -..

IEENa-\.'igamr e #Ang'o Platinum Kiosk Administration | &R-g:stnr for Access

« D angle Platinum Kiosk Adminia | B Ragistar for Accasd =

.&R&gis&r for Access
E:Lm; n Account Registration
i

a Account Details
Designation
Harma
Surnamas
i
Ermail
Pazsward
Confirm Password
Mobile
Tal

Fax

& _j % ig @C—n:c[

£ >

3.You may now:
3.1.Fill in the provided form and click Add to register for access
3.2.Click Login/ -1 to authenticate with your username and password
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User Guide 7

3 User Guide

3.1 Login/Logout

Using this forml =] you login to the system using your authentication
credentials.

= kioak Admin
& | Bgthantication

Usernamae or Email Address Admin

Passvaord  seses

F B (G Cancal | @ Forget | [ Reset @ L%n

If you forgot your password, complete your username or email
address and then click "Forgot"

3.2 My Account

Using this form[=! you check and update your current personal profile
information:

Account 1 Update

& | Arcount Details

Designation I
Name | Administrator Dasignation
Furnamie
D
Ermail | sdminBlkiosk.com
Username | Admin

Passvord | sewesn

Confirm Password | ssses
Mabile

Tl

Fas

& (&) Cancal

Simply complete and click Update.
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4

4.1
411

Administrator Guide

System Administration

Parameters

Here you can change various system-wide parameters

4 [l Kiozk Admin (Adminizgtratar)
Borogout
&My Account (Administrator)
rl ﬂﬂy!ﬁm Administration
_Hraramaters Qu
G accounts
LB Groups
() Global MuttiMedia
o Global Taxanomies
@ [k sites
JE!Sit- 1
& sdministrators
b @H.di-
¥ g4 Taxonomies
] Site 2
ikl site 1 Administration

gBisite 2 Administration

%Rtpnﬂ:

e S F D edw iF Mers nctions -

Harma . Valua
LecalGlobalMadiaPlayRatio 4

Ratio of Local v, Gichal media conbent exposure.
MaxContantDays 30

Maximum age of all displayed content
MaxGlobaiTaxenomies 8

Macimum runber global tarenemies aitowed
MaxlecalTaxanomied 4

Macimom pumber local Laxonomies allcwed
MaxlegDays 7

Maximwmn pumber of days awdit logs will be kept
MaxMadiaDays 366

Muximum age of all medis content.

LocalGlobalMediaPlayRatio

The ratio of the time slices
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allocated to Global and Local
content when displayed on a Kiosk's
LCD

MaxContentDays The maximum number of days
content will be available - from the
content's modified date this is the
number of days that elapse before
the content expires.

MaxGlobalTaxonomies The maximum number of global
folders to allow on the first screen
of a specific site - this will
automatically limit the maximum
number of taxonomy buttons seen
at the top of the kiosk's first
screen.

MaxLocalTaxonomies The maximum number of local
folders to allow on the first screen
of a specific site - this will
automatically limit the maximum
number of taxonomy buttons seen
at the bottom of the kiosk's first
screen.

MaxLogDays Maximum number of days to
keep audit logs for - will therefore
also influence the report summaries
available, i.e. if you only have a
month's logs, you can only get
reporting results for that month.

MaxMediaDays Maximum age of all media
content - from the content's
modified date this is the number of
days that elapse before the content

expires.
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412

413

Accounts

11

Use this folder's Grid|«| to add/edit/delete any existing registered
system user accounts.

‘ Accounts "
=5 BB | [ () ede | [ add | (5] Dalete | iF More Actions x| Search in colurn * | for
Status Dasignation Hama
Approved Administrator
Approved Sive 1 Admin
Approved % Tast2
Groups

This Grid|«]is used to rename some of the default system account

groups.

i} Grougs

FE LN
Hame

Administrators
Authenticated
Anonymous

Everyons

=

47 More Actions = Search in| colmn | e | some fext
Dascription Ermail
Administrators
Authenticated Users

Anonymous Users

All Users [%

o

#
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12 Kiosk Administration System

414 Global Media

Allows you to create hierarchicall=] media folders optionally
connected to content sources like URL[ =], HTML =), Pathl =], Path Filel =],

LDDMS/ =), LDDMS Document/ =], SharePoint| =) or SharePoint File| =),

etk Admin (Administrator) ] :i\ Global MultiMedia -
i
lLegout o
£ : Saarch in
i4!\--!:.- Account [Administrator) J ﬂ L .
§ System Administration Sequence . hama TYPY
’ 30 Madia L LEHD
=
_d R ke yrx- windk 3 domdos windargonalib, nxf
ﬂﬂccnunﬂ Ta#t Roormy’ WindargOned
Tt CR4CSICCTIARATATH IS T ITADR44FAS 1 FRAFBDEDIDEI6IADA ]
LS8 Groups Sorr e
4 '._.;'F Clobal MultiMedia 51 Madia 7 Pati
ﬁ”'dll 1 (LOOMS) 100 Madia 2 LDD
= . hitp - win eI domded windersonelib, nE £
o | Madia 7 (Fath) Text Roorm WindersOne L Testl/ Tawt Binder
] _‘ Cat 1 [Nona) 100 Madia 3 LED
() Copy of Media T (Fath) 100 Madia 4 LDD
#CII 1.1 (None) 100 Madia 5 LoD
i Media 1.4 (LODHS) 100 Cat 1 Ry
[ Media 1S (PathFila) 100 Media & L‘i; Leo
= hbtpfynarwinlk T dormdes windersonelib, nef
C.}'H*dll 2 (LODME] Test Roomy/ WindersOnel/ TestA/ Testl/ TestC/ TesiDy Test 2
r;“i]”ldll 3 (LODMS) 100 Madia 15 Pati
AFTORIR-5-LIC. poff
) Madia 4 (LOD
;' i - fErras 100 Madia 8 LoD
D) Media 5 (LOOMS) hetp o fyreswi arndhod! winddrEomnalib, mef
C 22ETITAODM4FSS |G AFBESSCIIBEOFEI 422574 564
il Media & (LEEMS) A RALC NI RATREMCI SRS, H
_thdlI B (LODMSFile) 42257 ITAMRHIFES 1 SIASBDED TDE 6 TALS 3
S 100 Tast Shad

Start by selecting the "Global MultiMedia" folder, then click the
Create menu and then select "Media". Continue by configuring/ =1 your

new folder and/or designating it as being of a specific type. If the

folder is of type "None", you can select it and then repeat the same

steps to add new sub/child folders.

415 Global Taxonomies

Allows you to create hierarchicall =] taxonomy folders (menu

structure) optionally connected to content sources like URL =], HTML/ =),
Pathl =), Path File[=], LDDMS| =], LDDMS Document/s], SharePoint/ =] or

SharePoint Filelss.
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oale Admin (Adminzstrator) -A- == Global Taxomomies =
lyLagout
. =} “E "E X Saarch in
o My Account [Adminkstrator)
T System Administration ERCURECEE ]
10 Global 111 |
Paramaters
= Te#t Room/ WinderdOnel/ Test! Teat Bindar 2
(i Accounts 12 Global 112
JETDUH‘I CHCS IO T ARATAZ LI S T ITAN RIS 1 CI487 I DAGESCH
F Tet Roomy WindersDnel/ Tesl’ Test Binder
¢G|Uhl| MultiMedia 14 Global 113
4 25 Global Tazonomies B& Clipd. bmp
) Global 111 (LDDNS) el Glebal 113
G Global 112 [LOOMSFile) 100 Global 1 1
[y Glabal 114 (PathFile) 5 Global 2
-y Global 113 (Path) 100 Glabal 3 [SitaName)]
_‘_l! (Nene)  uln} Glebal 4 [/
L]
100 Glabal 5 1
F _d,EInhll 1 {Nens)
100 Glabal & 1
J_d,'GIubll 1.1 {None)
100 Glabal 7 [|
o Glabal 1.1.1 (Nore,
s (one 100 Global 8 |
Tast 1.2.1.1 (WRL
] (urt) 100 Glabal 3 i
] Tast 1.1.1.2 (Padh
i e 100 Global 10
[#) Test 1.1.1.3 (HTML) best ppt
Global 10
@ Test 1.1.1.4 (LDDMS .
sl v ’ 100 11 i
TR S R T p—— |

Start by selecting the "Global Taxonomies" folder, then click the
Create menu and then select "SubTaxonomy". Continue by configuring
|21 your new folder and/or designating it as being of a specific type. If
the folder is of type "None", you can select it and then repeat the same
steps to add new sub/child folders.

416 Sites

If you select Sites and use the Create menu, you can add new sites
to the system.
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14 Kiosk Administration System

4 [l Kioak Admin (Adminiatrater)
BLogout
fs| My Account (Administrator)
4 7 System Administration
_Hraramaters Qu

ﬁ.q.ncau nits

_HGroups
(@ atobal MuttiMedia
oA Global Taxonomies
@ [k sites
4 gl site 1

ﬁﬂdmimllrlb:n

b \j" Madin

b A Taxonomies

ﬂ Site 2
EEsite 1 Administration
;.ESiI:- 2 Adrminigtration

akipnﬁl
B site 1 :: properties =l L
Srta ! Updakte
= | Sites
Hame  Site 1
Dascription | Site 1232
Currant Sits Loge Clip3.pnag
Hew Site Logo
Matts  fdgdigia
& =5 'E @ @ Cancel

Just complete the Site's Form!| =) by supplying a site name, short
description, uploading a new site logo (or choosing one of the previously
uploaded logos) and specifying a site motto.

Once the site is added, you can assign specific administers for it
using the "Administrators" taxonomy folder.
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‘ Administrators ol || 0 |
Group Approval
a | Group

Account | | =

Skatus ANODNYMOUS
Site 1 Ademin Sibe 1 Ademin, [:&
Test2 Test2,

= .E ‘E Page 1 aof 1 % pd

EIonE

15

You could now also assign some of the media and taxonomies you

created to the specific site. These will then become this site's Global

Medial 1 (which can not be changed by the Site Admins) and Global

Taxonomies| =1 (which can only be added to by Site Admins).

4.2 Site Administration
421 Users

These are a Grid|«! of all the kiosk users that have registered using

the smartcards.

© 2010 SciBit




16 Kiosk Administration System

T ——
4 g site 1 Administration
B V!
F @u.ﬂgiu.di‘
i {gielobal

b {ghsite
a4 @. Taxsnomies
i 4% Global (Top: max. B)
[ e Neves (Middle)
I 4 Local (Bottom: max. 4)

Jdﬁli!
# fb area 1

@ik administrators
o (W Kiosks
# M xkiosk 1 (1)
+ Glreporns
7 Generation Logs (last
Bandwidth
E Usage
Convarsisns
i [ Kiosk 3 (2)
b (P Multitiedia
b S5 Taxenomies
i+ /f, Emargencies
- Bl reparts
b fiyArea 2
b fiy aren 3
i fpares 4
4 ‘R‘pnﬂ:
.@ Generation Logs {last 10K entries)
[E] pandwideh
Usage
ﬁﬁnnurjmns
i+ gl site 2 Administration

b Usars =
3 B [E B edr | 3? More Actions - Search in cokimn
Employes 1o Hame a Sumame Company Operations Fag
1111 c B 2005-07
280039236 701224011108 Carina van der Wak 2005-08
123 Christian
7E90 Christian Burgaer
a0e 555 Christian Burger 2009-07
909 G589 Christian Burgar 2009-08
707 77 Christian Burgaer 2009-08
aee E F % 2009-07
43B9087F John Srmith
ang12111 Martin Johnson
a0B121112 Martin Johnson
95001727 Fiatar Walkinshaw 2009-07
545 Rory Underwood 2005-07F
? Tast Usar

1855 Tast2
757 will Carling 2009-07

You can only change the users' rights, e.g. enable an user to use the
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kiosk's training mode.

E"L:.n:.—i sl A

SiteUser : Updats

a | Users
Employee
o
Hame
SUFNEMS
Company
Operations
Raegistered

Rights L

[CJTraining Mods
A=k -L V'

422 Media

Allows you to create hierarchicall =] media folders (menu structure)
optionally connected to content sources like URL| =], HTML! =], Path| =],
Path File[=], LDDMS| =], LDDMS Document/ =], SharePoint/ =] or SharePoint
File[ s,

Your Site's MultiMedia is separated into two categories, Global and
Site:

© 2010 SciBit
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423

[T P e e s
4 @Slbt 1 Administration
E‘;U:lrs ﬁ
a :‘E MultiMadin
(@ clobal
@5“!
& .'I'i Taxonomies
A% Global (Top: max. B)
__:JH.M [Meddle)
_'r". Local (Bottorm: max. 43
& ;!]ﬂrlls
 fb Area 1
ﬂ.&dmml:tﬂutnm
o Kiosks
4 [ Kiosk 1 (1)
+ Bljreports
7 Generation Logs (last 1
[B] Bandwidin
E Uzage
E'{:ﬁﬂwr‘méﬂl
& Kiosk 3 (2)
(P multivedia
4 Taxonamies

1, Emargancies
.

Qj Reports
,E;.ﬁ-rll 2
,R_.Arll 3
LAMJ 4
+[jreparts

zi‘,'{" Generation Logs (last 10K entries)
[5] sandwideh

E Usaga

L"Jta:-nvtr:-nnl

ﬁ Site 2 Administration
—

The Global Media is what the System Administrator has assigned for

this site and can not be changed by a Site Administrator and will
automatically be activated on all kiosks attached to this site. The Site
Media however is fully customizable by the Site Administrator. Start by
selecting the "MultiMedia -> Site" folder, then click the Create menu and
then select "Media". Continue by configuring| =1 your new folder and/or
designating it as being of a specific type. If the folder is of type
"None", you can select it and then repeat the same steps to add new
sub/child folders.

Taxonomies

Allows you to create hierarchicall=1taxonomy and news folders (menu
structure) optionally connected to content sources like URL[ =], HTML/ =),
Pathlw), Path Filels), LDDMS| ), LDDMS Document/ ], SharePoint/[ ! or

© 2010 SciBit
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SharePoint File[ .

Your Site's Taxonomies are separated into three categories, Global,
News and Local:

e
A4 @s.m 1 Administration
E,U:il's ﬁ
a !‘_g: MultiMadin
{@clobal
@Sltt
# S35 Taxonomies
4 Global (Top: max. B)
___:Jhliu [Meddla)
_'ri. Local (Bottorm: max. 43
& ;!]-l"-rlls
4 Lﬂn‘-i 1
ﬂ.&dmml:tﬂutnm
o (M Kiosks
o ! Kiagk 1 (1)
# Bljreports
47 Generation Logs (last I
[B] Bandwidin
E Usage
E‘Cﬂﬂ“ﬂlaﬂl
M Kiosk 2 (2)
(@ multivedia
4 Texenomies
_!'__ Emargancias
By reparts
,E;.ﬁ-ril 2
,R_.-ﬁ-rll 3
M prea o
Fl %Rtpurﬁ

z‘}" Generation Logs (last 10K entries)
[B] Bandwidi
E Usaga
L"J-l:nnu'tr:-nnl
ﬁﬁiu 2 Administration
—

The Global is what the System Administrator has assigned for this

site and can not be changed by a Site Administrator and will
automatically be activated on all kiosks attached to this site. However,
you may add additional content folders to the Global taxonomy
hierarchy. Start by selecting the "Taxonomies -> Global" folder and/or
any subfolder below it, then click the Create menu and then select
"SubTaxonomy". Continue by configuring| =1 your new folder and/or
designating it as being of a specific type. If the folder is of type
"None", you can select it and then repeat the same steps to add new

© 2010 SciBit



20 Kiosk Administration System

sub/child folders.

The Site News corresponds to the 4 available news slots in the
middle of the first screen of the kiosk. These are also fully configurable

folders.

The Site Local taxonomy folders corresponds to the bottom 4 folders
available on the kiosk's first screen and is fully customizable by the Site

Administrator.

424 Areas
4.2.41 Area
A Site is constituted into physical site areas. You can add new areas

by selecting "Areas" and then clicking "Area".
¥ L
4 33 Taxonomies
_'_,_*. Global (Top: max. 8)
_.|Hl'm [Middle)
3 Local (Bottom: max. 4)
A =] .AHI:'I
4 _:'] Opan

2| Rafresh

L

;_:j Craate Mew i | & Aran
' Help on “Areas” T [% -
' Help i Hon Logs [last 1

i Favourites b fth

:i' Heaw Window 'v
fions:

@ Logout
(' MultiMadia
_'_r!. Taxonombes

L Emergencies

Brepors
Eﬂ.rvu 2

& | Aren

Dwscripkion

7 S Py By {5 cancal

When you click a specific area, you can also interactively change the
Kioware Group with which this area corresponds.
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[ p— L
& Afan

Hama Area 1
Description 12345
Kioware Group Default Sivs W

Default Site
= Anglo Flatinum Head Cfice - 55 Marshall Street .{l‘_r;
L= E 'E Tast Kiosk - Test Area

4.2.4.1.1 Administrators

Using this Gridl+] you can add new area administrators. An area
administrator may change and update an area's emergency procedures| )

‘ Administrators - 7| X
Group Approval
a | Group
Account | | =
Skgtusg  AMNDNYMOUS |
Site 1 Admin Site 1 Admin, [%
Test? Test2,
i J fb ‘E 1 4 Page L of 1 i :_ dd
SIOTE

4.2.4.1.2 Kiosks
You may add new kiosks by selecting "Kiosks" and then clicking

"Kiosk" on the "Create" menu. You should also select the physical
Kioware kiosk with which this system kiosk corresponds.

! Kigaka :: Kisgh (L8]
SAKiozk ¢ insat
a  Miosk
Hiovare Kiosk | Lo
o 4 ==
Dascription
Typa | Select Lo
Rasolution  Salect... =
Lacation
1]
HomePage URL
s -k (&) cancel | [ +
Kioware Kiosk The physical kiosk with which
this system kiosk corresponds
Area The area of this kiosk (if you
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22 Kiosk Administration System

would like to move the kiosk to
another area)

Name Short name or designation for
the kiosk

Description Short description of the kiosk

Type The type of kiosk, e.g. Kiosk,
Kiosk & LCD, LCD

Resolution Low, Medium or High resolution
capable kiosk

Location Physical location of the kiosk, e.
g. room number, etc

IP Network address of the kiosk, e.
g. IP Address.

HomePage URL The URL for the Kiosk's main
entry point

4.2.4.1.2.1 Reports

Here you will find reports of the following:

e Generation Logs, e.g. how and when each item in this kiosk's area

was generated

e Bandwidth, e.g. how much new data was copied to this kiosk per

year and month

e Usage, e.g. who used this kiosk when for what purpose per year

and month

e Conversions, e.g. how many documents have been converted for the

online doc viewer

4.2.4.1.3 MultiMedia

Allows you to create hierarchicall=] media folders (menu structure)
optionally connected to content sources like URL| =], HTML! =], Pathl =],
Path Filelw), LDDMS| ], LDDMS Document/ =], SharePoint/ ! or SharePoint

Filel s

Your Site's MultiMedia is separated into two categories, Global and

Area:
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I
4 @5.::- 1 Administration
E‘;U:lrs ﬁ
a :‘E MultiMadin
(@ clobal
@5“!
- :".;i Taxonomies
A% Global (Top: max. B)
Les|Heve (Middle)
43 Local (Bottormn: max. 4)
o ;!]-l'-\rlll:
@ fbarea 1
ﬂﬂ.dmmlsuatnrs
4 (8 Hiosks
4 [ Kiosk 1 (1)
+ Bljreports
2
[E] Bandwidth
E Uzage
E{:ﬁﬂ“rﬁbhl
& Kiosk 2 (2)
(P multivedia
S5 Texenomies
_[_ EmMargancias
Qj Reports
,E;.ﬁ-rll 2
parea 3
L.d.r-a 4
Fl %Rtpuﬂs

zi‘,'{" Generation Logs (last 10K entries)
[5] sandwideh

E Usaga

L"Jta:-nvtr::nnl

g Site 2 Administration
—

¢y Seneration Logs (last |

23

The Global Media is what the System Administrator has assigned for

this site and can not be changed by a Site Administrator and will
automatically be activated on all kiosks attached to this site. The Area
Media however can be assigned from any of the created Site's Medial v
folders. Start by selecting the "MultiMedia -> Area" folder, then click

the Create menu and then select "Site Media" to assign one of the

existing site media.

4.2.4.1.4 Taxonomies

Allows you to create hierarchicall =] taxonomy folders (menu
structure) optionally connected to content sources like URL[ =], HTML/ =),

Pathl=), Path Filelw), LDDMS| ), LDDMS Document/ =], SharePoint/[ ! or

SharePoint File[ s
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24 Kiosk Administration System

Your Site's Taxonomies is separated into the same three categories

as the Site's, Global, News and Local. These are not customizable and
read-only.

4.2.4.1.5 Emergencies

Allows you to create hierarchicall=] emergency procedure folders
(menu structure) optionally connected to content sources like URL/ =],
HTMLI =), Pathl=), Path Filel=), LDDMSI/ ), LDDMS Document/ =], SharePoint
|1 or SharePoint File| .

Your area's emergency procedures are unique and found below each
area:

I
4 ﬂSlbt 1 Administration
E,U:il's th
a :‘E MultiMadin
(@ clobal
@5“!
- :".;i Taxonomies
a4 Global (Tep: max. B)
Lis|Have (Middle)
43 Local (Bottormn: max. 4)
o ;!]-l'-\rlll:
Fl ‘H’,Ar-a 1
ﬂﬂ.dmmlsuatnrs
4 (8 Hiosks
4 [ Kiask 1 (1)
# Bljreports
47 Generation Logs (last 1
[E] Bandwidth
E Uzage
E-Enﬂwrl.ani.
& Kiosk 2 (2)
(@ multivedia
S5 Texenomies
_!'__ Emargancias
By reparts
,E;.ﬁ-rll 2
parea 3
M prea o
Fl %Rtpuﬂs

zi}" Generation Logs (last 10K entries)

[E] sandwidth

E Usage
L"Jta:-nvtr::nnl

il site 2 Administration
—

The Emergencies are fully customizable by the Site or Area
Administrators. Start by selecting the "Area -> Emergencies" folder,
then click the Create menu and then select "Emergency"”. Continue by
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configuringl =1 your new folder and/or designating it as being of a specific
type. If the folderis of type "None", you can select it and then repeat
the same steps to add new sub/child folders.

(@ MultiMedia
__'f, TExoASMisd
4 _:':. Emargancias

B Fire Dl {URL)
| _—J COpan
m““ _-} Actions

: k| @ acticate
fram 2 =
B # Refresh {E}

bm: 2
= i=] Renama
b-‘u:\ea &

aports El Proparties

7 Ganarg _E: Dalete

iEIndm k) Help on "Fire Brill {URL)

iu:-aue B Help 8
i Convad N

2 Adminig 1.0 Favourites k
rts |-Li Naw Window k
wdit Logs d Logout

[8T 1p L-E-1 BNPEVE R TR R TR R LT

sage (last 10K entries)

anversions (last 10K entries)

ccount Group Distribution g
chentvoe=delun s

After you have configured a new emergency procedure, you can
activate or deactive it by selecting it and then using the Actions menu.
Only one emergency can be active at any given time.

4.2.4.1.6 Reports
Here you will find reports of the following:
e Generation Logs, e.g. how and when each item in this area was

generated
e Bandwidth, e.g. how much new data was copied to each kiosk in

this area per year and month

e Usage, e.g. who used this area's kiosks and when for what purpose
per year and month

e Conversions, e.g. how many documents have been converted for the

online doc viewer in this area

425 Reports
Here you will find reports of the following:
e Generation Logs, e.g. how and when each item in this site was
generated
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e Bandwidth, e.g. how much new data was copied to each kiosk in
this site per year and month

e Usage, e.g. who used this site's kiosks and when for what purpose
per year and month

e Conversions, e.g. how many documents have been converted for the
online doc viewer in this site

4.3 Area Administration
43.1 Media
Allows you to create hierarchicall =1 media folders (menu structure)

optionally connected to content sources like URL| =], HTML! =], Path| =],

Path Filel=], LDDMS/ =] LDDMS Document/ =], SharePoint| ) or SharePoint
File/s.

Your Site's MultiMedia is separated into two categories, Global and
Area:
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[T P e e s
4 @Slbt 1 Administration
E‘;U:lrs ﬁ
a :‘E MultiMadin
(@ clobal
@5“!
& .'I'i Taxonomies
A% Global (Top: max. B)
__:JH.M [Meddle)
_'r". Local (Bottorm: max. 43
& ;!]ﬂrlls
 fb Area 1
ﬂ.&dmml:tﬂutnm
o Kiosks
4 [ Kiosk 1 (1)
+ Bljreports
7 Generation Logs (last 1
[B] Bandwidin
E Uzage
E{:ﬁﬂ“r‘méﬂl
& Kiosk 3 (2)
(P multivedia
4 Taxonamies
_[_ EmMargancias
Qj Reports
,E;.ﬁ-rll 2
,R_.Arll 3
LAMJ 4
+[jreparts

zi‘,'{" Generation Logs (last 10K entries)
[5] sandwideh

E Usage
L"Jta:-nvtr:-nnl

ﬁ Site 2 Administration
—

The Global Media is what the System Administrator has assigned for
this site and can not be changed by a Site Administrator and will
automatically be activated on all kiosks attached to this site. The Area
Media however can be assigned from any of the created Site's Medial v
folders. Start by selecting the "MultiMedia -> Area" folder, then click
the Create menu and then select "Site Media" to assign one of the
existing site media.

4.3.2 Emergencies

Allows you to create hierarchicall =] emergency procedure folders
(menu structure) optionally connected to content sources like URL/ =],
HTML=), Pathl=), Path Filel=], LDDMSI =], LDDMS Document/ ], SharePoint
|1 or SharePoint File|s!.

Your area's emergency procedures are unique and found below each
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area.

eI
A4 @5":- 1 Administration
E,U:il's th
a !‘_g: MultiMadin
{@clobal
@Sltt
4 2% Taxanomees
ah Global (Top: max. B)
Les|Heves (Middle)
44 Local (Bottormn: max. 4)
o :!]-l"-rll:l
# fiarea 1
aﬂ.dmmlsuatnrs
o4 _- Kiosks
ol ! Kiazk 1 (1)
4 Blreports
7 Generation Logs (last I
[E] Bandwidth
E Uzage
Ec,nnwmana
& Kiosk 2 (2)
(P Multivedia
S Texsnomies
L Emargancias
By reparts
E.-..ﬁ-rl: 2
paren 3
My prea o
E %Rtpum
z:r" Generation Logs (last 10K entries)
[B] andwidi
E Lisaiga
L"Jt,nnvm:.nnl
éSili 2 Administration
—,

The Emergencies are fully customizable by the Site or Area

Administrators. Start by selecting the "Area -> Emergencies" folder,
then click the Create menu and then select "Emergency"”. Continue by
configuringl =1 your new folder and/or designating it as being of a specific
type. If the folderis of type "None", you can select it and then repeat
the same steps to add new sub/child folders.
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4.4

(g MultiMedia
S, Temanamies
4 f, Emergencies

Bl Fire DAl (URL)
i ;j Cpen
Bhre sF Actions

bAsan 2

n ¥ Rafrash

iy Area 3

t}ﬂl‘ a 1=] Rename
a

i ] Properties

7 Ganerd j Delete

iE-Indwu ¥ Healp on "Fire Crill (UWRL)"

i Usage| g Halp

i Cadnyad N

1 Favouwrntes
2 Adminig T =

rts |_:| Maw Window

wdit Log= i Logaut

eneraticfrerger TresT T e Ty

sage (last 10K entries)

anvarsions (last 10 antries)

ccount Group Distribution

chentitme=deing

After you have configured a new emergency procedure, you can

Reports

Here you will find reports of the following:

Only one emergency can be active at any given time.

29

activate or deactive it by selecting it and then using the Actions menu.

e Audit Logs, e.g. which accounts logged into the KioskAdmin System

and when

e Usage, e.g. who used this site's kiosks and when for what purpose

per year and month

e Conversions, e.g. how many documents have been converted for the

online doc viewer in this site

e Account Group Distribution, e.g. how many accounts are there per

group.
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5

5.1

Common Concepts

None Folder

All [virtual] folders in the system

Content Classification

Seguence 100

Hame Global 1

Dagcription

Ll

Hone [ex. Folder iz & grouging category)

shares the following properties:

I
Status | Normal -
Expiry Date 2008-12-12 =
End Time -
= '& "3 2} Cancel Update
Sequence The sequence of the folder in it's
parent folder's child folders, i.e. is
it the first, second or last child.
Defaults to 100 and can be any
positive integer value.
Name Display name of the folder
Description A short description of the folder
Type All folders in the system can be
earmarked as of a specific source or
content type
Status Allows you to earmark the

content as either Normal or
Important (which makes a
difference on how often the content
is displayed on LCD Kiosk Displays)

Start & Expiry Dates

Allows you to specify folder-wide
content validity period
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Start & End Times Use this to change from when
until when the content may be
displayed during the day.

Implicit folder characteristics:

e A folder is called "virtual" as by default it is not a reference to a
physical folder or directory structure and of type "None". However a
folder can also be statically linked to different types of dynamic
content.

¢ A folder of type "None" may have one or more hierarchical child
folders below it. All other types of folders are considered to be

end-points.

52 URL Folder

Is any virtual folder of type URL. It requires only a single additional
property which is the full web address of the page you wish to display.

Change URL

& Folder URL

URL (Full wab sddress) [| T

*

Full wab addrass to rascuros

A3DB i) Cancal

53 HTML Folder

Is any virtual folder of type HTML. It requires only a single
additional property which is the HTML content you wish to display. The
HTML Editorl =1 allows you to upload HTML content like images, flash, etc

as well.
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Site I Medis 3 HTML Editer

(=] Sourea | ] (£ | H) o - B o

T E @ MR e E R

B I U s x x'| |=i= B EFEE AN |« O oE [ =& oy
| e - | Foumat » | Font - | Sizm - T Rl |
Mo Content [%

@ Canoel J: Save

54 Path Folder

Is any virtual folder of type Path. It requires no specific properties,
as it will automatically create a physical folder to which you may upload
files. Further the following optional properties are available:

Options Choose between displaying only
the Latest File or All Files found in
the source

Sort By Choose between sorting by
Name or Modified Date

Direction Choose between sorting
ascending or descending

Shared Path
Notes Your shared folder will be crested on the server when you click
Upaelnbe.
Optigns  Latest File £
Saort By | Namae LS
Dirsction | Ascanding D% -
F oy (i) cancal | Update

55 Path File

Is any virtual folder of type Path File. It requires only that you
upload a new file (subsequent to which you may pick any of the
uploaded files as the one you wish to be displayed on the kiosk)
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& Sites

Currant File |

Hew File

Change file

e,

i} Cancal Updata

5.6 LDDMS

Is any virtual folder of type LDDMS (Lotus Domino Document

Management System). It requires the following properties:

Library Your LDDMS Library to use

Username Your LDDMS Username

Password Your LDDMS Password

Binder The unique binder ID of the
binder's documents to display (or
use the dropdown tree editor pick
your binder)

Options Choose between displaying only
the Latest File or All Files found in
the source

Sort By Choose between sorting by
Name or Modified Date

Direction Choose between sorting
ascending or descending

= | Falder Path

Library
Usamama

Fassword

Change folder

hitp:f My win2k3/ domdoc/ windersonelib.naf I
lacgues

lllllllll

Binder Tast Room/WindersOnael/ Test2/CS4CS1CC7IATATAZAZZE w

Opticns
Saat By

Direction

Latest File >
Nama w

Ascending nr
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5.7 LDDMS Document

Is any virtual folder of type LDDMS Document (Lotus Domino

Document Management System). It requires the following properties:

Library Your LDDMS Library to use
Username Your LDDMS Username
Password Your LDDMS Password
Binder The unique binder ID of the
binder's documents to display (or
use the dropdown tree editor pick
your binder)
Document The binder document to be
displayed
e
Library
Usemama I
Pasemord
Binder | | Passwaord =
Document =
- L i) cancel

5.8 SharePoint

Is any virtual folder of type SharePoint (Microsoft SharePoint (SP)).
It requires the following properties:

Server URL Only the main domain part of
the SP server URL, e.g. http://www.
domain.com

Username Your SP Username

Password Your SP Password

List The unique list ID of the SP list's
documents to display (or use the
dropdown tree editor pick your list)

Options Choose between displaying only
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the Latest File or All Files found in
the source

Sort By

Choose between sorting by
Name or Modified Date

Direction

Choose between sorting
ascending or descending

= | Folder Path
Server URL anly
U@
Password
Lisk
Oipkigns
Saodt By

Direction

7 5%%

Change folder

http:f fhynoewin2 ke B.scibit.com/ I

Test Room/WindersOne 1l Test2/CS4CS1ICCTIATATASAZZE »w

__Q:I Cancel 1 Update

59 SharePoint File

Is any virtual folder of type SharePoint File/Document (Microsoft

SharePoint (SP)). It requires the following properties:

Server URL Only the main domain part of
the SP server URL,
e.g. http://www.domain.com

Username Your SP Username

Password Your SP Password

List The unique list ID of the SP list's
documents to display (or use the
dropdown tree editor pick your list)

Document The list's document to display
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- changefolder

| = Folder Path
Server URL anly | I,_ |
Usernama |
Password |
= il
Document | h]
rg= L % | @) cancel | [ Update

37
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6 MyLook Guide

6.1 |

ntroduction
Welcome to SciBit's MyLook WebClient Graphic User Interface (GUI).

Tz : Bsonymeos Deer -
Sexmice  : R42.188.5.118 Anglo Platinum Document Management System Tloemss: Trisl sxpizee in 14 duf
[fmin. Sfmin remais] 2008-02-19 11:24 £liess : Myleok Eeblisse 3.8
Filg * Viaw* Folder * Windew * Help ~ Type restion i J. € s
i
Eujvigjt¢r || “FAnglo Platinum DMS
f_"‘ . = 3 K 3 _ P

j@lngbn Platinum DMS [Ancnymaus Usar) - " Favauribas Coammunicatio. .. Wl carparata Gav,..

@ amandalbult Saction AW R - =¥ More Acions»

= i“ ASSL ——

Ldangle Platinum Contracts : : ;
B Communication And Publications 2007 Anglo Platinum Intrim Results Presentation
L Dravings And Specifications
_'| General Platinum Way
WiRecord Keeping
U reference Lists
LA Templates And Farms
A Training Mabarial
i Working Documents
& i erpm
= 'J C010 - Corporate
—_-'l Corporate Governands
iy Operational Governance
S} Templates And Forms
= '_i CO0Z0 - Head Office
—_:'l Corporate Governands
i\ Reference Lists
S} Templates And Forms
o 'j C0Z0 - Drawings and Pictures
@ & commueciat
= '_-“ Corporate Communications
L3 angle Platinum Contracts !{_ _)_|
L= P PR ST P ‘ Puga 1 af 1 PR Displaying 1 = 1 of 1

Sarvice: LODMY Rabferwice 2007.2

The MyLook WebClient GUI is a loosely connected interface for
multiple, very diverse and non-visual web services and other systems.
It has also been described as a portal containing webservices as
portlets. The primary goal is to have a simplified and common
interface for very diverse systems and services that is familiar to users
accustomed to desktop applications, thereby avoiding the need for
extensive training in any particular system.
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Clientside: i MWyl ook Servers
MyLook GUI L SOAP
i
I

----- =

]

I

;

. 1
Wiebserviced
!

B 1
!

I

]

!

I
App.
L Service

!
|
| !
App. y
Service
]

1

i

App. )
Service

|

N
Service
Some App Modules are ! !
installed. Updates & : !
! !

Upgrades are maintained by

OR, thin Service
making the non-

GUI's AutolUpdate feature I Myl ook
. SR App Service
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6.2 Concepts

The MyLook WebClient GUI (graphic user interface) is a loosely
connected interface for all systems and web services. Items common to
the MyLook WebClient are:

o Layout/

« Navigatorf «1

o Grids|«)

e Forms/ =)

o Editor] =]
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6.2.1 Layout

The WebClient uses a common and familiar layout used in many
applications and even websites today:

Anglo Platinum Business Interest Dedaration |
IF-'I- * View* Folder ¥ * Halp ¥

iy a3
Eﬂlvlgmr X gls Platinum Business Interest Dadaration / 5 My Business Intorests / K cu

Angle Platinum Buginass Interest Daclnrati..
i My Business Interests

I Current interests

i Hiskosical intarests

Legal Entity Ne

? Third party declarations done by m
L& My Profile

H{_‘umtnl: profile

& Audit Log I
G My Business' Interasts

& Administration Contents
Navigation

\ Y, &\E..._,i W.,/l

From top to bottom and in order from left to right:

e Application/Service/System name

e Version and Licensing information of the current system
o Context sensitive main menu

e Help search facility for the whole system

« Navigation Pane/Window or Navigatorl « for short

e Contents Pane/Window

Resizing

Unlike older web sites, and as a Web 2.0 interface, the MyLook Web
GUI will automatically resize to fill all available area in your web
browser. Therefore the usable space is only limited by your screen size
and the size and position of your web browser's window. It is also
possible to resize the navigator using the resize split bar control next to
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it, thereby increasing or decreasing the contents pane. Alternatively the
navigator can be collapsed completely using the double arrow collapse
button on it.

Other items

Items part of the GUI but of lesser importance:

e Using the View menu, you can change the layout's theme, i.e. color
schema

e Using the View menu, you can change the WebClient mode, e.g.
Normal, Minimum, Accessibility

e Using the View menu, you can enable or disable Tabbed content

windows.
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6.2.2

Navigator

The navigator can be found at the left-most part of your web
browser. The navigator's primary function is to facilitate navigation to
different parts, folders or functionality of a system. Depending on the
specific application, the navigator structures all information in a
hierarchical manner, either as simply folders with subfolders or as
categories with subcategories and items, as is depicted below:

Anglo Platinum Business Interest Declaration |
IFiIl * View*™ Folder* * Halp~

Navigator ‘ﬁ
E
Angle Platinum Business Interast Daclarati..

cid' My Business Interasts
./ Current interests

i Historical interasts

? Third party dedarations done by me

4

& My Profile
& Current profile
(}_h Audit Log I
S My Business’ Intarasts ]
= Administration Contents

Navigation

N i A

Each navigation item has associated with it functionality which can
be accessed using either the main Folder or Actions menus.
Alternatively, you may select a specific item and right click it to get the

same context sensitive menus.

It should be understood that within the navigator each folder or
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category is said to contain/classify all sub-folders or subcategories
implicitly. Therefore any sub-folder or subcategory should be seen in
the context of it's parent folder or category. For example, in the image
above, "My Business Interests" is the parent category of the
subcategory/sub-item called "Current Interests". Therefore one should
deduce that "Current Interests" are not any interests, but are in fact
specifically "My Business Interests" current items. Or in other words,
one can describe the item fully and superfluously as "My Current
Business Interests".

It is also important to understand that by selecting a specific item in
the navigator, the Contents Pane will update with the default
information for the selected item. Therefore, the Contents Pane in tumn
is context sensitive to the selected Navigator item.
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6.2.3 Grid

Grids are used in the GUI as a way to display 1 or more system
items/records in a tabular format.

glo Pstinurm Business Interest Declaration / My Prefile / & audit Leg

Saarch in

Clasz Subclazs

Inkarant Updnta

Upgdate

Hacgs- .o Vanter 2007-11-12 14:12:15
2007=11-12 14:05:13

Interest

Igques Venker

oques Venber 2007-11-12 12r10:44 Policy Inberest
acquEs Vanbar 2007-11-12 12:04:32 Policy Inkarast
BEquEE Vantar 2007-11-12 12:01:00 Dalic-f Inbasgal
acques Vanber 2007=-11-12 08:43:51 Agcount Authentication
acques Venber 2007-11-07 11:52:18 Policy [nterest
acquEs Vanbar 2007-11-07 11:45:32 Arcount Authantication
aequas Vanbar 2007-11-05 13:30:33 Bzeount Authantication
acques Venter zo07-11-01 72 nta ntS“f“ KRems f Authentication
acques Venber 2007=11-01 15:23:47 Policy Submission
acques Venber 2007-11-01 15:23:4F Hm‘ds Submission
acques Vanbar 2007-11-01 14:52:04 Breount Authantication
acques Venber 2007-11-01 08:42:50 Account Authentication
acques Venber 2007-10-20 09%:52:51 Agcount Authentication
acques Vanbar 2007-10-18 10:34:49 Policy Inberast
acques Vanbar 2007-10-18 10:34:37 Palicy Inkarast
acques Venber 2007-10-16 10:33:44 Azcount Authentication
acques Venber 2007-10-18 10:33:25 Agcount Authentication
acques Vanber 2007-10-18 10:31:98 Policy Policy

acquEs Vanbar 2007-10-18 10:29:18 Breount Authantication
acques Venber 2007-10-18 10:25:47 Palicy Inbasest
acques Venber 2007=10-18 10:24:33 Bccount Aaurthentication

cques Venber 2007-10-18 10:22:43 Account Authentication
ligques Venter 2007-10-18 09:00:38 Dnl::'f Interast
%l >

I e Risalaios incars i 22 ol )

From top to bottom a grid consists of:

e Grid Heading - Use to display so called bread-crumbs (context
sensitive path to the grid within the system).

e Grid Main Tool Bar - A tool bar containing many toolbar buttons
specific to the selected item within the grid

e Grid Column Header Bar - A row with one column heading name per
table column

e Grid Contents - The contents contained in the grid

e Grid Footer Bar - A tool bar used for paging through the items and
displaying positional information.
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Grid Heading

It is possible to click any of the crumbs in the heading to

automatically navigate|«] backwards (up the folder/category levels)
within the system.

Grid Main Tool Bar

This tool bar contain many buttons connected to specific functionality

pertinent to the selected item/record within the grid.

Some of the standard buttons are from left to right:

o [ First - Positions to and selects the very first record in the grid.

o il Previous - Positions to and selects the record prior to the
currently selected one.

o [d Next - Positions to and selects the record after the currently
selected one.

o [ Last - Positions to and selects the very last record in the grid.

e = Print - Opens a new browser window, reformats the current grid
contents into a simpler HTML version ready for direct printing to any
desktop printer.

o ‘B Export to XML - Exports all records (including those outside of
the current page size) to an XML table which desktop application
like MS Excel can then use for further formatting and computational
work.

o “I3 Export to PDF - Opens a new browser window, reformats the
current grid contents into a simpler Acrobat PDF version.

o #| Refresh - Reloads the current records (as someone else may
have made changes to the data)

o [d Edit - If allowed by the system, allow you to edit the currently
selected record using the subsequent Form/ =!

e 5 Add - If allowed by the system, allow you to add a new record to
the system using the subsequent Form/ !
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o [ Delete - If allowed by the system, allow you to delete the
currently selected record using the subsequent Form/

e +~ Search - Allows you to pick any column in the grid capable of
being filtered by the system, and then specify any text to search for
in that column. You can either click the »* button or simple press
Enter or Tab after typing in your search criteria text to have the
system apply the condition. If you do this without specifying any
text and the selected column already had a filter condition, the
condition will be removed.

Grid Column Header Bar

This row contains a heading for each column of data displayed. You
may resize individual columns by dragging the split bar between them
with your mouse. You may also sort ascending, - descending, lock,
unlock, show, hide and filter for specific column values by right clicking a
specific column's heading and using the subsequent pop up menu.

If you simply click a column heading, your records will automatically
be sorted according to that column's contained data.

Grid Contents

The grid contents is wholly dependent on the context in which you
are within the system, which in turn is dictated by the selected
Navigator| «] folder or category item.

Please note that the contents of your grid may also contain a
vertical and/or a horizontal scrollbar should your screen or browser
size be too small to fit all records and all their columns.

Grid Footer Bar

The main purpose of this tool baris to display the number of
displayed records within the grid as well as the total number of records
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available on the system. It also allow you to page through all records
25 at a time using the left most controls on the tool bar. For
performance and efficiency, the system is designed such that at any
given time it will only display 25 or less records in a grid. Therefore, if
the system has 100 records to display, you will only see records 1 to 25
first up. You will then need to click the Next Page button or specify a
specific page to go to, to view the next 25 records. The Page navigation
buttons function similarly to the Record navigation buttons, but instead
of moving a distance of only 1 record in the record set, they allow you to
move by 25 records at a time.
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6.24 Form

Forms are used to add, edit or delete single records/items in the
system individually.

'—-'-.r".n-;I-:- Platinum Business Interest Declaration / B My Business Interests [ "% Current interests

l Interest a

I Person with interest AD: Jacques Venter, Softeare Enginear [GMSI - [CT] oG

Company Hame

I ¥ This field is required

Legal Entity No [Company Na. OC 1234557890 %
Na, Trust Ho, etc)

Natura of interest hald Sharehcider e

Hature of business (2.9, Software Enginesring
Engineering. Printing, atc)

What conflict of interest, if any, None
doas this interest [ relationship
have batwean yourself and the
Anglo American Group of
Companies (including Anglo
Platinum) and, if the case where
the intarest s hald by a direct
family membar, what s the Nature
of the intarest?

%% Shareholding 13

Dats whan this interest starked | 2006-11-05 4
ware obtained / bought / acquired

ol

Diate that you disposed of your
interest in this entity

[ @ save |[ @ cancel |

¥ Prink” SAcrobat b

In order from top to bottom, each form consists of:

e One or more field groups each with a caption, ex. "Interest"

e One or more field controls, each with a label, edit control and
optional pop up descriptive hint

e One or more field controls with error conditions, i.e. a field which
contains invalid data when validated by the system

e One or more action buttons, i.e. buttons used to Save or Delete the
displayed data, Submit the information, Cancel any editing, etc

e Print and Acrobat format links, i.e. links which will convert the
current form and containing data into standard HTML or PDF
document.

Numerous field controls exist, each applicable to certain types of
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information, for example:

Text Editor - Used to edit a single line of textual information

Date Editor - Used to obtain a valid date from you providing a
datetime picker control to help with the selection

Dropdown Editor - Used to allow you to select one or optionally more
items from a list of valid items
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6.2.5 Editor

The HTML/Web Editor of the GUI allows you to change, edit and
format rich text type information.

-t.ﬂ.ngle Platinum Business Interest Declaration [ -.-'i.-.l.dminiltrltinn I ;chlluﬁnn Policy = -}E’dit
. — T . " —— = T
: [2] Sowes | b ] £ | ] [ o | N i &Lk @ hel 30 H =l A
B Z U X[IEiE FEESAMe s LfEdeTES Q2
| Sigle - | Fremat ~ Fort Ariad - Size «|; 44~ %2~

R R R R R R I BBEBBBEEEESSSB=u—mN,
/ 1, [Acciame) [AccSurmame], have an interest (investments and other) in 3
the Tollowing DUSINEsses rganisanons, which | hereby decane in
accordance with the snglo Platinum Declaration of interest Prooedure,
Code of Ethics and Business Principles Paolicy.

MOTE: that employees are not required to declare every ime they sell
their interests in a public company and declaration of Interast excludes
trading in public listed company shares during a3 year where the
employes holds less than 5% of the total shareholding of that company

\ v,
From top to bottom, the editor consists of:

e Main Tool Bar - A tool bar with various functional buttons.
e Contents - An area used for editing/word processing the information

The tool bar contains standard rich text editing features as would be
expected from a normal desktop word processing application, ex. Copy,
Paste, Insert Table, Bold, Italic, Font styles and sizes, etc. You can
also use the Source button to edit the HTML directly. Once done, you
should click the Save button to submit and have your changes saved to
the system.
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7 Technical Guide

7.1  System Requirements

The prerequisite system requirements for the web application
installation are:

e Hardware
» The system has the same hardware requirements than those of
Microsoft Windows 2000, XP or 2003 Webserver.
e Software
» PHP 5.2.6 with the following modules and settings enabled:
M SimpleXML
M PDO and SQLite
» [IS5.10r6
= MS Internet Explorer 6 or later, or Firefox 1.5 or later.
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Assumptions
An assumption is made that the following is installed, using a
default configuration, and functional at the time of the web application
installation:
e MS Windows 2003 Standard Edition Server
¢ IIS 6.0
e PHP 5.2.6 or later.
PHP is distributed with a Windows Installer. People prefer
mostly to set it up manually, for which there is excellent
documentation on the PHP website (http://www.php.net) or online

tutorials like http://www.peterguy.com/php/install_IIS6.html.
short, this process usually includes the following steps which can
be accomplished in a couple of minutes:
» Renaming php-ini-recommended to php.ini
» Setting the cgi.force_redirect variable to 0 in the php.ini
» Creating a session storage folder and setting the session.
save_path variable to it
» Setting up the extensions and setting the extension_dir
variable to the php\ext sub folder.
Specifically:
1.1 extension=php_pdo.dll
1.2 extension=php_pdo_sqlite.dll
1.3 extension=php_sqlite.dll
= Adding the PHP installation folder to your system's PATH
variable
» Setting HKEY_LOCAL_MACHINE\SOFTWARE\PHP\IniFilePath =
C:\PHP
» Adding the PHP CGI to the IIS Web Extensions and enabling it
» Adding the ".php" extension to your Default Website or to the
applicable Virtual folder where PHP will be used
» And enabling your website/virtual folder for "Scripts Only"
execution
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» Finally restarting the IIS

e It is also assumed that you have downloaded and are in possession
of the latest version of the system which are usually distributed as

a single ZIP file at http://www.scibit.com

7.2 Installation

The installation process is fourfold. The following installation
procedures should be undertaken in the same order as presented below.
o 11S[+7]

o Application| ]
o PHP/s]

e IIS / NTFS| =]

721 IS

1.0pen your IIS Manager console.

2.Create a virtual folder below your default website and call the alias
"mylook"

2.1.Pick and/or create a new folder below your InetPub\wwwroot, ex.
"InetPub\wwwroot\mylook"

2.2.Ensure that you check "Read" and "Run scripts"

3.Right click the new virtual folder and select Properties - Virtual
Folder - Configuration.

4,.0n the Mappings tab, ensure that the ".php" extension has been
added, points to your "php-cgi.exe" and works for All Verbs.

5. Click OK.

6.Go to the Documents tab and ensure that the "index.php" file is
added as a default content page for the virtual folder.

7.Make a note of the Application Pool used for the Virtual folder.

8. Click OK.

9. Go to the specific Application Pool in the IIS Manager folder
structure, right click for Properties and ensure the Predefined
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Property is set to Local Service on the Identity tab.

You may also setup a specific user account to use here, but by
default this will ensure the context of IUSR_* of the machine is used.

7.2.2 System

1.Unzip your System's installation file to the new virtual folder.

2.New sub-folders should appear called "client", "shared" and the
application's folder, i.e. "vesta", "lddms", "kiosk", etc.

3. 0pen the mylook\client\config\services.xml file in an Editor like
Notepad and change / update the first Service's URL to point to
your web server's application default file, i.e. typically this should
be "http://localhost/mylook/[vestal|lddms|etc]/[vestallddms|etc].
php", but may differ depending on your specific website used and
virtual folder name picked.

4.Save the file.

5.0pen the mylook\[vesta|lddms|etc]\config\sites.xml file in an
Editor like Notepad and change / update the first Sites's Root to
point to the folder you want the application to use, i.e. typically
this might be "c:/[extranet|vesta|lddms]" and should for security
reasons not be part of your website's virtual folder.

6.Save the file.

723 PHP

1.To ensure that PHP is functional, browse to your client folder with
the test parameter, e.g. http://localhost/mylook/client/?type=test.

2.Also ensure that the following PHP extensions are enabled:
2.1.extension=php_pdo.dll

2.2.extension=php_pdo_sqlite.dll
2.3.extension=php_sqlite.dll

7.24 NISINTFS

1.0pen Windows Explorer and add the machine's IUSR_* account (as
was configured in the last step in IIS, step 9) to the root folder's,
i.e. "c:\share", security, allowing for at least read and write access.
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You should now be ready to use your application, i.e. http://
localhost/mylook/client/ URL's.
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8.1

Support Guide

Support

Various support channels are available:
e Email

e Website

e Forum

e Report a bug

61

© 2010 SciBit



mailto:support@scibit.com
http://www.scibit.com
http://forum.scibit.com
http://projects.scibit.com/index.php?m=helpdesk&a=addedit

62 Kiosk Administration System

Index
A -

active directory 7

_C -

concepts 41

_E -

editor 52

general 42, 44, 46, 50, 52
grid 46

introduction 2, 39

L -

layout 42
ldap 7
load 4
loading 4

_N -

navigator 44

_P-

profile 7

quick

4

© 2010 SciBit



	Introduction
	Quick Guide
	Loading

	User Guide
	Login/Logout
	My Account

	Administrator Guide
	System Administration
	Parameters
	Accounts
	Groups
	Global Media
	Global Taxonomies
	Sites

	Site Administration
	Users
	Media
	Taxonomies
	Areas
	Area
	Administrators
	Kiosks
	Reports

	MultiMedia
	Taxonomies
	Emergencies
	Reports


	Reports

	Area Administration
	Media
	Emergencies

	Reports

	Common Concepts
	None Folder
	URL Folder
	HTML Folder
	Path Folder
	Path File
	LDDMS
	LDDMS Document
	SharePoint
	SharePoint File

	MyLook Guide
	Introduction
	Concepts
	Layout
	Navigator
	Grid
	Form
	Editor


	Technical Guide
	System Requirements
	Installation
	IIS
	System
	PHP
	IIS/NTFS


	Support Guide
	Support


